8.0 FEMIS GIS Database

The FEMIS spatial data resides on the UNIX server and on each PC that is running FEMIS. The master
copy of the spatial database resides on the server and contains the static GIS themes, the FEMIS ArcView
GIS project file (FEMISGIS.APR), the GIS initialization file (FEMISGIS.INI), two map symbol files
(MARKERDF.AVP and OBJ_TYPE.LUT), several bitmap (.BMP) files that provide images for special-
purpose buttons on the custom ArcView GlSinterface, and initial versions of the dynamic GIS themes.
When FEMISisfirgt installed on each PC, the spatial database files for the relevant CSEPP hazard site
are copied from the server to the \FEMIS\GIS\<SITE CODE> directory and associated subdirectories on
the PC. During subsequent FEMIS version upgrades, selected spatial data files may be copied to a PC as
necessary to apply changes or additionsto the spatial data.

The following paragraphs discuss the components of the spatial database and the methods used to
maintain, configure, customize, backup, and troubleshoot the spatia database.

8.1 Spatial Data Description

The FEMIS spatial database is made up of a number of themes or layers. Each theme contains data
(location information and descriptive attributes) representing a collection of geographic objects of a
particular type (e.g., roads, political boundaries, meteorological towers, and emergency planning zones).
The spatial database also contains a customized ArcView GIS project file, an initidization file that tells
ArcView GIS what themes are to be loaded into the project file and how to display them, and an optional
legend file associated with each theme that provides additional information on how to display the theme's
dataon the map. For detailed descriptions of the individual FEMIS spatial datathemes, please refer to
Section 3.3, Building Spatial Data, in the FEMI S Data Management Guide.

8.2 Spatial Data Maintenance

The static spatia datathemes are built from various data sources. These themes normally change
infrequently, and such changes are made either by regenerating the entire theme from new or updated data
sources or by making minor editing changes in the existing theme data. For detailed information on how
to maintain or upgrade the static data themes, please refer to Section 5.0, Managing Spatial Data, in the
FEMI S Data Management Guide.

AsFEMISisbeing run, the datain the relationa database that corresponds to the dynamic spatia data
themes (e.g., facilities) may be atered by users that have the appropriate FEMIS privileges. As necessary
during its operation, FEMIS automatically regenerates the spatial datafiles for these dynamic themes on
each PC based on the current datain the relational database. No additional action by your System or
Database Administrator is necessary to maintain these themes under normal circumstances.
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8.3 CSEPP Zone Editor

The CSEPP Zone Editor allows sites to make modifications to the GIS Emergency Planning Zone Theme.
Changes are made in the GIS Zone theme, and then the Oracle database information is updated. Thefinal
step isdistribution of the new GIS Zone theme. Changes to the zones could make existing Risk Areas
invalid. You may want to delete existing Risk Areas before using the Zone Editor. The Zone Editor can
only be applied to CSEPP zones. If changes are required for other hazard “zone” themes, contact PNNL
for assistance.

Each step is described in the following sections. Prior to beginning zone editing, please contact PNNL
for an updated script to be used in Section 8.3.2, Updating the FEMIS Database.

8.3.1 GIS Operations

Zone editing in the GIS uses four zone menu options under the ArcView GIS Edit menu. This capability
isonly available if the user has GIS Full Access privileges. In the beginning, only the Start Zone Editing
option isvisiblein the Edit menu. The other three options are enabled only if aNewZones.shp themeis

added to the view.

Step 1: Start Zone Editing

Ensure you have GIS Full Access privileges. Loginto FEMIS and start the GIS from the FEMIS Map
button on thetoolbar. If you have GIS Full Access privileges, the f button will be enabled. Pressthe f
button on the ArcView GIS toolbar to change to the full GIS capability. Under the Edit menu option,
select the Start Zone Editing option. The theme NewZones.shp is added to the current view. If
NewZones.shp does not exist in the zone directory, FEMIS will createit by copying the existing zone
theme to the file NewZones.shp.

Step 2: Edit the NewZones.shp Theme

When the NewZones.shp isloaded, edit it using standard ArcView GIS editing functionality. Name and
zone |D can also be modified in Step 3 using the Change Zone Attributes menu option.

Step 3: Execute the Change Zone Attributes Option

Before alowing any changes, this option checks the NewZones theme structure to make sure it complies
with the rules below. Y ou can review this structurein the GIS by activating the Zone themein the GIS
and clicking the Table button. After edits have been made, the Zone Editor will provide warning
messages if your structure is not consistent with the rules below. Do not change the existing order of the
fields.

» All FEMISrequired fields are of type CHAR except for zone_id, which is numeric.
* Theshape field should contain the value polygon.
* Thezone_id field should be numbers of less than 10 digits.
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» TheType field should be 8 characters or less.

»  The Zone field should be 30 characters or less.

* ThePar_Pad field should be 20 characters or less.

* TheRisk_Area field should be 20 characters or less.

» The Objecttype filed should be identical to the Type field in both structure and entries.

* The Objectname field should be identical to Zone field in both structure and entries.

»  Each zone must have a unique ID and name.

» Additional fields are also permissible and should be added at the end of the existing list of fields.

This Change Zone Attributes option lets the user modify the zone name and type for al selected zones.
Y ou may run the script several times, if needed. The name and ID changes areimmediate. If you make
an error, you can repeat the operation with the correct information. If necessary, you can delete the
NewZones.shp file and begin again.

Step 4: Create Text Files Listing Zone Attribute Changes

Under the ArcView GIS Edit menu, select the Promote Zone Attribute Changes to DB option. This option

creates the input files needed to promote the changes to the database as described in Section 8.3.2,

Updating the FEMIS Database. The two files created are ZONENAMECHANGES.TXT and

ZONETYPECHANGES.TXT. Thesefileswill be written in the GIS home directory (specified asthe

GISTopDirPC in the FEMIS.INI file). The option creates the files by comparing the old and new zone

shape files and writing the changes to the aforementioned two files.

Before performing any comparisons, this option checks whether the zone IDs and names are unique. If

not, the user will be notified and no comparisons will be performed. The user will need to returnto

Steps 2 or 3 to make zone names and 1Ds unique.

The format of the ZONETYPECHANGES.TXT isasfollows:
[ID]old_type|new_type|class_id|subclass_id

There will be onerecord in the ZONETYPECHANGES.TXT file for each renamed or added zone.

* Renamed zones will have al fields. The old_type may be the same as the new type if there was only
a zone name change.

* New zones have anull old_type and the appropriate zone type in the new_type field.
The format of the ZONENAMECHANGES.TXT is asfollows:
[ID]old_name|new_name|zone_type|class_id|subclass_id|zone_num|eoc_name|

There will be onerecord in the ZONENAMECHANGES.TXT file for each deleted, renamed, or added
zone. Except as noted below, none of the fields should contain null values.
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» Deleted zones will appear asthe first records in the ZONENAMECHANGES.TXT file. For deleted
zones, the new_name isnull. The deleted IDswill not be listed in the Type file.

»  Renamed zones records will follow the deleted zone information in the text file. For name changes,
the record lists the zone ID, the old zone name, new zone name, and zone type.

* New zoneswill list the zone number, have a null old_name, and the EOC with primary responsibility
for the zone.

The number of changed records s reported in an interactive message to the user. If an error occurs, use
the ERRORLOG.TXT filein the GIS home directory to troubleshoot the problem.

Step 5: Create Text File Listing Facility-Zone Relationship Changes

Under the Edit menu option in ArcView GIS, select the Promote Point-In-Zone Changes to DB option.

This option creates the file FACWITHZONECHANGES.TXT. FACWITHZONECHANGES.TXT isthe

input file needed to make changes to the zone-facility relationship in the Oracle database. The file will be

written in the GIS home directory (specified as the GISTopDirPC in the FEMIS.INI filg).

The format of the FACWITHZONECHANGES.TXT fileisasfollows:
[facility_name|eoc_name]|old__zone_name|new_zone_name)|

Thefile contains arecord for every facility that has been affected by the zone changes.

» If afacility used to be inside a zone' s boundary but now falls outside any zone boundaries, the
new_zone_name Will be set to null.

» If afacility used to be outside zone boundaries but is now within a zone, the old_zone_name will
be null.

» If azone change changes the zone in which afacility islocated, al fields will contain data.
Before performing any comparisons, this process will check whether the zone |Ds and hames are unique.
If not, the user will be notified and no comparisons will be performed. The user will need to return to

Step 3 to make zone names and 1Ds unique.

The number of changed records and the list of changes are also reported to the user in an interactive
message.

Step 6: Examine the Text Files and Make Corrections (if necessary)

It is essential that the . TXT files are correct to avoid corrupting the Oracle database. Review thefiles
using atext editor to make sure the following conditions are met.
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Ensure that each file ends with a carriage return.

Null values are not allowed in the first field (ID) in any of thesefiles. The other parameters must be
compatible with the format of the fields in the database. For example, for zone name changes, the
old_name and new_name must be 30 characters or less and must begin with a pha character.

For the ZONETYPECHANGES.TXT file, nulls are only alowed for the following conditions. All other
nulls should be replacedwith the appropriate information.

e old_type isnull for new zones.

For the ZONENAMECHANGES.TXT file, nulls are only allowed for the following conditions. All other
nulls should be replaced with the appropriate information.

* old_zone_name is null for new zone records.

* new_zone_name isnull for deleted zones.

» zone_type may be null for deleted zones.

* Class_id and Subclass_id may be null for renamed zones and deleted zones.

* eoc_name may be null for renamed or deleted zones. Ensureit isthe eoc_name rather than the
eoc_code.

For the FACWITHZONECHANGES.TXT file, ensure there are no null fields and that the eoc_name field
containsthe eoc_name rather than the eoc_code. (In certain cases, the GIS cannot determine the
eoc_name, S0 insertsthe eoc_code instead.) Use the editor to replace the eoc_code with the eoc_name.

8.3.2 Updating the FEMIS Database

When the GIS editing has been completed, follow the steps below to update the FEMIS database. The
steps assume the user is familiar with text editing and updating the Oracle database and using SQL
scripts.

1. Ensure the /home/femis/database/zonedt directory exists. If zone editing has been done before, the
directory will exist; you may want to rename or move the existing *.txt and *.sql files to preserve the
previoudy edited files. If this directory does not exist, createiit.

2. Movethethree output files created in Section 8.3.1, GIS Operations, from the PC to the UNIX server
into the /home/femis/database/zonedt directory. Copy the zone_edit_db.sh file from the
/home/femis/database/dba directory to the /nome/femis/database/zonedt directory. After copying
thefile, check the file privileges for execute and change if necessary.
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3. Execute the UNIX shell script named zone_edit_db.sh. The script will check on environment
variables and for the presence of the eoclist.dat and eocnum.dat files in the /home/femis/etc directory.

If all conditions are met, the script will read the three *.txt input files and produce one output file,
which contains the actual script to modify the database. The output file is named
zone_edit_change.sql. Review thisfileto ensure all changes have been included by comparing it to
the *.txt files.

4. Check to seeif you know al of the Oracle EOC database passwords, and reset them to the default
valuesif required. (See Section 12.2.2, Password Management for the Relational Database, for
instructions.)

5. Commit the database changes by running the output script using the SQL*Plustool. The script will
ask the user to enter the exercise number for the datathat is being edited. Normally thisis0 for
operational data. The user enters the exercise number and the Enter key to input the val ue.

If there are no error messages, the user continues by pressing the Enter key. If any errors are noted,
stop the process using Ctrl+C, fix the problems, and rerun the script until it is error free.

To do thisstep, login to UNIX as femis, move to the zonedt directory, start sqlplus, and run the script
asfollows:

% su — femis

% cd /home/femis/database/zonedt

% sqlplus

SQL> @zone_edit_change.sql

SQL> {a series of outputs will be displayed, look for any errors}
SQL> exit

>

6. Reset the Oracle database passwords to their more secure values, if they were modified in Step 4.
(See Section 12.2.2, Password Management for the Relational Database, for instruction.)

8.3.3 Distributing the New Zone File

To complete the zone editing process, rename NewZones.shp shape files to the old zone theme name
(e.g., <sitecode>_ez.shp). (Thesefiles are both located in the <GIS DRIVE>\FEMIS\GIS\<SITE>\ZONE
directory on the PC used to do the GIS editing). Copy it to the GIS directory of al the PCsin all EOCs
replacing the old theme. The FUPDATE utility described in Section 15.2, FUPDATE.BAT, inthe
FEMISIngtallation Guide may be used. Also replace the zone shapefile on the master copy of the
spatial database which resides on the server so future installs will use the updated zone file.
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8.4 GIS Configuration

When you install FEMIS using the full GIS installation option, the complete GIS directory structure and
all datafilesreferenced by the selected FEMISGIS.INI file (see the following paragraph) are copied from
the server to the FEMIS\GIS\<SITE CODE> directory and associated subdirectories on your PC. This
may take several minutes, depending on the volume of data to be copied for your site and the speed of the
network.

Y ou will be given an option to choose from among several versions of the FEMISGIS.INI file. The
FEMISGIS.INI file specifies primarily the spatial themes that are to be installed and used to build the
operational ArcView GIS APR file for use with FEMIS. For most CSEPP sites, three choices will be
available: small, medium, and large.

A small, or minimum, FEMISGIS.INI file installs only the theme files that are essential for running
FEMIS (e.g., zone boundaries, igloos, and facilities) or to provide a minimum map background for
location reference (e.g., state and county boundaries, major roads, and populated place names). The mid-
size FEMISGIS.INI file includes most of the themes, but does not include large image files and other large
nonessential themes (e.g., contour lines and streams). A large, or maximum, FEMISGIS.INI fileinstalls
all of the currently available GIS themes for the Site.

To have the most complete GIS, choose the largest FEMISGIS.INI option that will comfortably fit within
the available memory space on your hard drive. However, additional themes may negatively impact the
speed of GIS response. The setup program will provide information on the space required to install each
option and the amount of space available on your hard drive. To create a custom GIS configuration that is
different from any of the three optional predefined configurations (FEMISGIS.INI files), you will need to
copy the largest FEMISGIS.INI file to your PC and then edit it according to the instructionsin Section 8.5,
Customizing the FEMIS Map.

Upon completion of the GIS data installation, the \FEMIS\GIS subdirectory will contain the
FEMPTY.APR and one or more <SITE CODE> subdirectories. Each \FEMIS\GIS\<SITE CODE>
directory will contain a number of subdirectories, each subdirectory containing the datafiles for one or
more specific themes. The main \FEMIS\GIS\<SITE CODE> directory will also contain the
FEMISGIS.APR and FEMISGIS.INI files. A specia subdirectory, \FEMIS\GIS\<SITE CODE>\LOOKUP,
contains severa bitmap (.BMP) files that provide images for special-purpose buttons on the custom
ArcView GlSinterface, and two symbol files (MARKERDF.AVP and OBJ_TYPE.LUT) that include
information used to generate the theme classification legends. These legends are used to display different
map symbols or icons based on the value of adesignated attribute within a GIS theme. For example,
facilities can be assigned symbols based on the facility type, such as schools or hospitals. The following
section discusses methods you can use to modify symbols in the default symbol lookup table, add new
symbols to this table, and change the assignment of symbolsto classes of attributes (e.g., facility types) in
the FEMIS spatid themes.
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8.4.1 Symbol Lookup Table

The symbol lookup tableislocated in the <GIS INSTALL DRIVE>\FEMIS\GIS\<SITE CODE>\LOOKUP
directory under the file name OBJ_TYPE.LUT. Thelookup table specifies the symbols to be used to
create the theme legends.

Each line consists of seven entries separated by vertical bars as delimiters. Linesthat begin with asingle
guote are comment lines and will be ignored by FEMIS. Blank lines are aso ignored.

Thefirst five fields are numbers corresponding to a symbol type, color, size, background color, and
outline color. These numbers reference symbol attributes from within the active symbol palettesin
ArcView GIS. Thefourth and fifth fields are only used in polygonal themes. The sixth entry specifies
the theme type or object category, and the last entry specifies the theme subtype or classification label.
The symbol type and color numbers designate the order in which the symbols are listed in the FEMIS GIS
pallet window using 0 for the first element. The symbol sizeis measured in “points’ (/72 of aninch). In
polygonal themes, the “size” number is used to set the outline width. If the classification label is missing,
it should be set to none.

An example of the lookup tableislisted below. From the facility entries, we can see that school facilities
are represented with the 89th symbol, colored with the 46th color, and measure 12/72 of aninch. To
customize the lookup table, use the GIS Configuration Editor (see Section 8.5.3) or edit the fileusing a
text editor.

'Symbol | Foreground  |Symbol | Background | Outline | Object | Classification
‘number | color | size | Color | Color | Category | Label

6 | 16 | 2 |0 | 14 | zone | Depot

7 | 16 | 2 |0 | 14 | zone | IRZ

9 | 16 | 2 | O | 14 | zone | PAZ

8 | 1 | 2 |0 | 4 | county | OR

8 | 1 | 2 |0 | 44 | county | WA

0 | 8 | 2 | | | road | Primary

0 | 8 | 1 | | | road | Secondary

1 | 7 | 1 | | | road | Local

26 | 46 | 10 | | | tcp | Access

26 | 51 | 10 | | | tcp | Traffic

26 | 50 | 10 | | | tcp | Traffic/Access
26 | 51 | 10 | | | tcp | #NULL#

125 | 51 | 10 | | [facility |airport

89 | 46 | 12 | | [facility |school

96 | 46 | 14 | | [facility [shelter
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8.4.2 Symbol Defaults

The MARKERDF.AVP file contains the symbols loaded in the default FEMIS symbol palette. Y ou may
change these symbols using the generic ArcView GIS palette window functionality. Y ou may use any of
the other symbols provided by ArcView GISin the C\ESRNAV_GIS30\ARCVIEW\SYMBOLS directory.
Y ou may also import symbols from ARC/INFO or iconsin raster format. If you delete or change the
sequence of the exigting symboals, then some of the FEMIS GIS “look and feel” will change. For

example, if you change the 42nd symbol from a cross hair (O) to an asterisk (*), then the object (e.g.,
facility) locationsin the FEMIS GIS will be depicted with an asterisk instead of the familiar cross hair.
Y ou may add new symbols at the end of the palette and use the symbol lookup table (Section 8.4.1,
Symbol Lookup Table) to refer to the new symbols.

8.5 Customizing the FEMIS Map

Y ou can customize the content and appearance of the FEMIS map by editing the original FEMISGIS.INI
file or any of the alternate INI files to create a custom FEMISGIS.INI file that can then be used to create a
custom APR. The GIS Configuration Editor, described in Section 8.5.3, can help you edit the
FEMISGIS.INI file and the lookup table. Y ou can add new themes; delete existing themes; change the
minimum or maximum scal e display thresholds; modify the type, color, and size of line or point map
features; change the legend names; designate the label (and if applicable, classification fields); specify the
default classification fields; designate an alternative directory (and if needed, an aternate drive) for the
data source of non-point themes; and control which themes are visible by default when the GISisfirst
started. A detailed description of the fields in the FEMISGIS.INI fileisin Section 8.5.1, Customizing the
FEMISGIS.INI File. Y ou can aso import your own symbols from other ArcView GIS, ARC/INFO, or
raster icons by changing the symbol lookup table and the FEMIS default pal ette as described in

Section 8.4.1, Symbol Lookup Table.

If you customize your FEMIS Map, please keep track of the changes to ensure they can be retained during
future FEMIS or GIS upgrades.

8.5.1 Customizing the FEMISGIS.INI File

The FEMISGIS.INI file contains data required to initialize GIS parameters that generate the
FEMISGIS.APR and to ensure proper GIS contents each time the FEMIS GISisinvoked by the FEMIS
application. An example of the FEMISGIS.INI fileis shown at the end of Section 3.0, FEMIS GIS
Migration and Configuration, in the FEMI S I nstallation Guide. The contents of the FEMISGIS.INI file
are discussed below.

The FEMISGIS.INI file is automatically updated anytime you define a new dynamic theme or modify an
exigting one. If you have an abnormal termination of the FEMIS or the GIS, the dynamic themes section
of the FEMISGIS.INI file may be corrupted. To restore the file, you can delete all of the theme entries
below the facilities theme. These entries are for the user-defined themes, and they will be regenerated the
next time you start FEMIS.
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Blank lines areignored in the FEMISGIS.INI. Lineswith asingle quote in the first column are recognized
as comment lines and areignored. Vertical bars delimit the data fieldsin the FEMISGIS.INI. No data
value should contain avertical bar. String values do not need to be quoted.

The [FEMIS_VERSION] section specifies the FEMIS version for which this .INI file can be used. The
next line specifies the size of the themesin the current .INI file. Valid size values are small, medium, or
large.

The [SITE_CODE] section specifies the CSEPP site code that the GIS data describes. This parameter
should be identical to the corresponding site code in the FEMIS.INI file, otherwise the GIS will not work.

The [DEFAULT_HAZARD_THEME] specifies the theme that is to be used for the “zone” theme for the
current hazard. Zone themes within FEMIS are used to create risk areas and protective action decisions.
Each hazard has a zone theme specified for use with that hazard.

The [PROJECTION_PARAMETERS] section specifiesthe UTM (Universal Transverse Mercator)
projection and coordinate system parameters required for the site. The parameters shown in the example
arefor UTM Zone 16 (appropriate for Alabama).

The [AREA_OF_INTEREST] section specifies a geographic area of interest. The area of interest for
FEMIS has been set as arectangle that starts at the origin (lower left corner) of -126.00 degrees longitude
and 23.00 degrees latitude and spans 58 degrees longitude (first size parameter) and 27 degrees latitude
(second size parameter). This covers the continental United States. The area of interest is specified to
minimi ze the consequences of ill-defined datapoints. In certain circumstances, the user is given the
opportunity to define the longitude and latitude where an event has occurred. The FEMIS GIS does not
allow the specification of plumes or threat wedges that originate outside the area of interest.

The theme parameters sections specify the configuration for the themes to be loaded in the FEMIS GIS.
Thetwo sectionsare: [STATIC_THEMES] and [DYNAMIC_THEMES]. The dynamic themeflagis
determined based on the section in which the themeislisted. Parameters for each theme are discussed
below. The sameinformation is included as commentsin the FEMISGIS.INI fileitsdlf. It has been
omitted from the example to conserve space.

* Theme — Indicates the theme name in the FEMIS Database.

* FEMIS Access — For feature themes, this column contains a Yes or No to indicate whether the theme
isinthe FEMIS object table. For image themes, this column contains None or the name of an image
catalog to be created. |If the name of an image catalog is listed, the image catalog should be described

in one of the theme parameter entries of thisini file.

*  Type — The Type column must contain one of the following valid types: Image, ImgCat, point, line,
or polygon.

* LoadFlag — This column indicates whether to load the theme (Yes) or not to load the theme (No).
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e Status — Indicates the visibility of the theme when forming the APR.

» DisplayOrder — Indicates the order in which themes will appear in the GIS Table of Contents. The
theme indicated by the smallest number will appear at the top of the table of contents and will be
loaded last (on top of al the other themes). The display order may be negative.

* Label Field — Indicates the field name to be used as the default l1abeling field.

*  Object Category — Indicates the FEMIS theme category. The value must be one of the typeslisted in
the \HOME\LOOKUP\OBJ_TYPE.LUT file. Currently, valid values are zone, county, igloo, facility,
tcp, road, and siren. If the valueis None then the classification field should & so be set to none and
the default legend field should be set to simple, indicating the theme may not be classified using the
lookup tables.

» Default Legend — Indicates whether asimple or classified legend isused. Valid values are simple,
none, and classify. Simple indicates a simple legend that uses one symbol to depict al the theme

data. None is used for image themes for which a classify legend does not apply.

* Classification Field — Indicates the field to be used to classify the legend. If the classified legend does
not exist it will be created.

*  Min Scale — Indicates the minimum scale denominator at which atheme will be displayed.

* Max Scale — Indicates the maximum scale denominator at which atheme will be displayed.

* Legend Name — Indicates the name to be used in the legend in the View table of contents.

* Customize — For Dynamic themes, Yes indicates the current symbol parameterslisted in later
columns of this record should be used and should not be overwritten when this dynamic themeis
updated. No indicates the symbol parametersin this record should be overwritten with values from
the FEMIS Oracle database when this dynamic theme is updated. Customization is not applicable for
static themes so the field should contain N/A for static themes.

*  Symbol — Indicates the symbol to be used in asimple classification.

» Color — Indicates the foreground color for theme symbols, if they can be colored.

» Size-—Indicates the symbol size.

*  BackGround Color — Indicates the background color for polygona symbols.

* Outline Color — Indicates the outline color of polygona symbols.
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Path — Indicates the location of the file for the theme. The path is appended to the GIS home
directory specified in the FEMIS.INI file for the GIS data under the keyword FemisgisTopDirPC.

Alternate Prefix — Indicates alocation other than the one specified in the FEMIS.INI file should be
appended to the path. The script that loads themes appends the path to this prefix to locate and read
an alternate source directory. This can be used to access data | ocated somewhere other than your PC
hard drive. Any auxiliary fileswill be written using the home prefix.

8.5.2 Altering the Default FEMIS Map

To ater the default appearance of the FEMIS map, use the Use at Startup option for FEMIS GIS
ViewMarks (see the FEMIS Help). For more extensive changes, complete the following steps:

1.

Copy or rename the original \FEMIS\GIS\<SITE CODE>\FEMISGIS.INI file to another name (e.g.,
FGISORIG.INI) so you can retrieve it and use it later, if necessary. Do the same with the original
APR (e.g., copy and rename it to \FEMIS\GIS\<SITE CODE>\FGISORIG.APR). Then make another
copy of the original INI file or one of the alternate INI files. Usethe GIS Configuration Editor or
manually edit the copy to

a) Exclude themes, remove (or comment out using a single quote in the first column) lines defining
existing themes that you want to exclude, or specify No in the load flag.

b) Add linesto define new themes.
¢) Moaodify the appropriate parameters of existing themes as desired.

Run ArcView GIS using the empty project file, \FEMIS\GIS\FEMPTY.APR, by double clicking on the
file name in the Windows NT Explorer. When the APR has finished loading, it will contain the
FEMIS static themes indicated in the FEMISGIS.INI files and will create the FEMISGIS.APR filein
the GIS home directory (\FEMIS\<SITE CODE>\GIS). When the FEMIS application |oads the
FEMISGIS.APR, the changes made to the dynamic themes will be depicted.

Examine the theme legends to see that the correct set of themes was loaded and the correct ones are
visible. The dynamic themes will not appear in the legend at thistime. These themes are loaded
when FEMIS activates the FEMISGIS.APR. Then examine each themeto see that it displays
correctly (check the checkbox in the legend to make visible the themes that are invisible by default).
If some themes are not displayed correctly, recheck the INI file. If necessary, exit ArcView GIS, edit
the INI file to make corrections, and then repeat Steps 2 and 3.

Exit ArcView GIS. Use Windows Explorer to set the FEMISGIS.APR file access properties to Read-
only. The FEMISGIS.INI and FEMISGIS.APR files you just created will be used each time the
FEMIS GISis started.
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8.5.3 GIS Configuration Editor

The GIS Configuration Editor is a stand-alone program that provides an easy to use interface for
modifying the FEMISGIS.INI and OBJ_TYPE.LUT files.

Note: Make abackup copy of the FEMISGIS.INI and OBJ_TYPE.LUT files so that you can
recover from an unsatisfactory editing session.

The[SITE_CODE], [DEFAULT_HAZARD_THEME], [PROJECTION_PARAMETERS], and

[AREA_OF INTEREST] sections of the FEMISGIS.INI file can be modified on the main window. The
[STATIC_THEMES] and [DYNAMIC_THEMES] sections are displayed in a spreadsheet on the main
window. Lineswith asingle quotation mark in the first column are recognized as comment lines and are
ignored.

To modify an individual spreadsheet entry, select the row and click the Details button or double-click on
therow. The GISwill be started and a details window will be displayed for that row. All thefields are
described in Section 8.5.1, Customizing the FEMISGIS.INI File. The symbol parameters for shape,
color, and size can be entered using the text boxes or by clicking the Map button and selecting a symbol
from the palette. The GIS can be used to preview the symbols and determine the appropriate symbol
parameters.

If the Map button is pressed, the GIS will be brought to the foreground with the ArcView GIS palette
active.

Use the ArcView GIS palette to modify the color, shape, or fill pattern, and the size of the drawn symbol.
When satisfied with the symbol appearance, click the Return Symbol Parameters button. The appropriate
numbers for the symbol, color, shape, or fill pattern, and the size will be returned to the Detail s window.
Thesizeis measured in /72 of aninch. For lines, it designates width. For polygons, the sizeis used for
the width of the outline.

The Legend Symbol tab is used to add, edit, or delete entries from the OBJ_TYPE.LUT file. The symbol
parameters for shape, color, and size can be entered by using the text boxes or by clicking the Map button.
The GIS can be used to preview the symbols and determine the appropriate symbol parameters.

If dynamic themes or the OBJ_TYPE.LUT file have been modified and saved, close the GIS and restart to
implement the changes. For static themes, once the changes have been saved to the FEMISGIS.INI file,
follow the instructions found in Section 8.5.2, Altering the Default FEMIS Map, to alter the default
FEMIS map.

8.5.4 Theme Projection Utility

FEMIS uses the projected theme datain Universal Transverse Mercator (UTM) coordinate systemin
order to avoid re-projecting geographic coordinates each time the view isrefreshed. To include new
themesin FEMIS, they should be converted to UTM. The Theme Projection Utility converts feature
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themes in geographic coordinatesto UTM coordinates for the desired CSEPP site. Image themes, which
arerequired to bein projected coordinates, are skipped by the Theme Projection Utility. Image themes not
already in UTM would need to be modified using other software such as ARC/INFO.

When you open PROJECTION_UTILITY.APR, ArcView GIS will start, and a window containing two
Viewswill display. View1, thework area, is on the left side; and View2, where the results are depicted, is
on theright side.

The Theme Projection Utility assumes that the input themes are in geographic coordinates and will let you
select themes from alist of existing shape filesin Viewl so they can be exported as projected shape files
using the currently specified projectionin Viewl. The exported files are added to View?2.

To use the Theme Projection Utility, complete the following steps:

1. Double-click on the PROJECTION_UTILITY.APR (usually located in your C\FEMIS\GIS directory).
2. Click View > Properties > Projection.

3. Select the Standard radio button, and Geographic will display in the Type field.

4. Load the themes you want to project. Click the + (Add Theme) button.

5. Click the Export Projected item under Utilities, and click OK on the brief information window that
displays.

6. Select the desired CSEPP site from thelist, and click OK.

7. Make any necessary adjustments to the UTM projection parameters for the selected site, and
click OK.

8. Navigate to the desired directory or accept the default (usually C:\TEMP), and click OK.
9. Select the themes you want to export from the list of the themesin View1, and click OK.

If the name of the theme being converted already existsin the selected directory, atemporary name
will be suggested for the converted theme. Click OK to accept the temporary theme name.

The conversion process will start and the status bar will indicate the progress of conversion. The new
theme(s) will be loaded in View2 so you can visually verify the results. Y ou may want to load some
of your other themes, like raster images, to check how well the projected coordinate match the
existing themes.

10. Click Exit under the File menu to close the PROJECTION_UTILITY.APR file. Click No on the
message about saving changes to thisfile.
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8.6 Backup Procedures

Theinstallation directory for the spatial data on the UNIX server is/home/femis/gis. This current
operational GIS datais copied to the PCs when FEMIS isinstalled or upgraded. It isrecommended that a
tar tape of this directory be made each time anew version of FEMISisreceived. The tape should be
labeled FEMIS GIS Data with the date and FEMIS version number included. If the GIS data on the server
should become corrupted or deleted, the spatial data can be restored from the backup tar tape without
having to perform areinstallation of FEMIS on the server.

If asite customization of the spatial data and/or the APR and INI filesisto be done, the origina GIS data
directory should first be copied to another directory (e.g., /home/femis/data/v<x.y>/gis, where <x.y> is the
FEMIS version number associated with the released data. A second tar tape of the GIS directory should
be made following the completion of the GIS customization.

8.7 GIS Database Troubleshooting

A number of factors can cause errorsin loading or displaying the spatial data themes or undesirable
display behavior or appearance. Some of the more common problems are listed bel ow, aong with some
suggestions for finding and correcting the problems.

Displayed Themes Shrink or Disappear

Zoom to All Themes may cause displayed themes to shrink to avery small portion of the display screen,
or to disappear entirely. Thisistypically caused by themes having one or more objects with “improper”
latitude/l ongitude coordinates, e.g., (0,0) or any point that is far from the “area of interest” surrounding
the hazard site. For most of the point themes, you can check the attribute table associated with the theme
(activate the theme legend and click the Table button on the ArcView GIS button bar). Search the
latitude and longitude columns for values that are noticeably different from the majority of objectsin the
theme. Attempt to verify the correct coordinates for points that are suspected to be outside the area of
interest.

Improperly Defined Themes

Error messages similar to Unable to Access Theme or Index Out of Range may occur when attempting to
accessthe GIS. These errors are most often caused by improperly defined themes, such as an empty
theme (a theme with zero map objects). Check the text file (.EVT file) associated with al dynamic point
themes to make sure each theme contains at least one data line in addition to the header (column names)
line.

Loading Theme Data Classification Errors

Classification errors may occur when attempting to load theme datainto an empty APR. They can occur
on themes with legends that classify and display the map objects based on a column in the theme's
attribute table (e.g., zones are classified and displayed by zone type: Depot, PAZ, IRZ.). The error could
be caused by the wrong field name being designated as the classification field in the FEMISGIS.INI file.
Check the attribute table for the offending theme in the APR.
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The error could also be caused by a new data value for the classification column that was not included in
the values defined in the theme' s legend (.LEG) file. Regenerate the FEMISGIS.APR from the empty
APR using the process described in Section 8.5, Customizing the FEMIS Map. Make surethat all the
entriesin the classification field are included in the \FEMIS\GIS\<SITE CODE>\LOOKUP\FEMISGIS.LUT
file.

Delayed Refresh During Zooming

Display refresh delays may occur during zooming. For example, the GIS may take an inordinate amount
of time to refresh the map display when zooming into a very small area of the map. These lengthy delays
can usually be attributed to one or more of the larger themes (map images or vector themes with alarge
amount of data) that does not have an appropriate lower display limit. To check the display limits of a
theme, activate the theme legend, select Properties under the Theme menu, and then click Display. The
minimum scale should never be less than 10 for themes with alarge amount of data, such as roads,
streams, census block boundaries, or raster map images. A larger minimum scale (e.g., 100) may help to
reduce the zoom-in redisplay time significantly.

Inappropriate Scale of Raster Map Images

The appearance of raster map images may be degraded and may detract from the viewing of other themes
if displayed at an inappropriate scale factor. Follow the procedure described in Delayed Refresh During
Zooming above to check the display limits of a map image theme and set the limits to appropriate values
for the map scale at which the original scanned map was created. If theimage is alowed to be viewed at
scalesthat are too small compared to the map’s base scale (e.g., 1:200,000 for a 1:24,000 scale quad sheet
map), the image will appear too small to be readable and will clutter the display. If theimageisallowed
to be viewed at scales that are too large (e.g., 1:1,000 for a 1:24,000 scale map), the individual pixels of
the digitized map will be enlarged so much asto give the portion of the map being viewed a*“blocky” and
unfocused appearance. The best scale range will vary depending on the resolution and quality of the
scanned image. A general guideline isthat the scale value (denominator of the scaeratio, e.g., 24000 for
ascae of 1:24,000) should have its minimum set to about 20 percent of the map’s base scale value (e.g.,
around 5000 for the 1:24,000 example), and its maximum set equal to or dightly larger than the base
scale value (e.g., around 30000 for the 1:24,000 example). A greater range may be used if the map image
is of very high resolution and quality.

Automatic Update of FEMISGIS.INI File

The FEMISGIS.INI file is automatically updated each time you define a new dynamic theme or modify an
existing one. If FEMIS or the FEMIS GIS terminate abnormally, the dynamic theme section of the
FEMISGIS.INI file may be corrupted. This can be fixed by deleting all the theme entriesin the
FEMISGIS.INI below the Facilities theme entry and then restarting FEMIS. The entries below Facilities
in the FEMISGIS.INI are for the user-defined themes and are regenerated from the Oracle database the
next time you start FEMIS.
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